• No part of this manual may be reproduced in any form.
• All specifications and designs are subject to change without notice.

The export of this product is subject to the authorization of the government of the country from where the product is exported.

In this manual we have tried as much as possible to describe all the various matters. However, we cannot describe all the matters which must not be done, or which cannot be done, because there are so many possibilities. Therefore, matters which are not especially described as possible in this manual should be regarded as “impossible”.

This manual contains the program names or device names of other companies, some of which are registered trademarks of respective owners. However, these names are not followed by ® or ™ in the main body.
This manual includes safety precautions for protecting the user and preventing damage to the machine. Precautions are classified into Warnings and Cautions according to their bearing on safety. Also, supplementary information is described as Notes. Read the Warnings, Cautions, and Notes thoroughly before attempting to use the machine.

⚠️ **WARNING**
Applied when there is a danger of the user being injured or when there is a damage of both the user being injured and the equipment being damaged if the approved procedure is not observed.

⚠️ **CAUTION**
Applied when there is a danger of the equipment being damaged, if the approved procedure is not observed.

**NOTE**
The Note is used to indicate supplementary information other than Warning and Caution.

- Read this manual carefully, and store it in a safe place.
1.1 GENERAL WARNINGS AND CAUTIONS

The following warnings and cautions describe the safety precautions related to the use of CNC units. It is essential that these precautions be observed by users to ensure the safe operation of machines equipped with a CNC unit.

⚠ WARNING

1. Before operating the machine, thoroughly check the entered data. Operating the machine with incorrectly specified data may result in the machine behaving unexpectedly, possibly causing damage to the workpiece and/or machine itself, or injury to the user.

2. Never attempt to machine a workpiece without first checking the programmed value, compensation value, current position, and external signal settings. Also, never attempt to machine a workpiece without first checking the operation of the machine. Before starting a production run, ensure that the machine is operating correctly by performing a trial run using, for example, the single block, feedrate override, or machine lock function, or by operating the machine with neither a tool nor workpiece mounted. Failure to confirm the correct operation of the machine may result in the machine behaving unexpectedly, possibly causing damage to the workpiece and/or machine itself, or injury to the user.

3. Ensure that the specified feedrate is appropriate for the intended operation. Generally, for each machine, there is a maximum allowable feedrate. The appropriate feedrate varies with the intended operation. Refer to the manual provided with the machine to determine the maximum allowable feedrate. If a machine is run at other than the correct speed, it may behave unexpectedly, possibly causing damage to the workpiece and/or machine itself, or injury to the user.

4. When using a tool compensation function, thoroughly check the direction and amount of compensation. Operating the machine with incorrectly specified data may result in the machine behaving unexpectedly, possibly causing damage to the workpiece and/or machine itself, or injury to the user.
WARNING
5 The parameters for the CNC and PMC are factory-set. Usually, there is no need to change them. When, however, there is no alternative other than to change a parameter, ensure that you fully Failure to set a parameter correctly may result in the machine behaving unexpectedly, possibly causing damage to the workpiece and/or machine itself, or injury to the user.

CAUTION
1 The operator's manual on the CNC screen display function does not cover the functions and operation of CNCs. For details of the functions and operation of a CNC, refer to the operator's manual for the CNC.
2 Some machine operations and screen functions are implemented by the machine tool builder. For an explanation of their usage and related notes, refer to the manual provided by the machine tool builder.
3 The CNC screen display function is designed to allow standard CNC screens to be displayed on the monitor of a personal computer. With this function, the same operation as the standard CNC operation can be performed. However, there are some operations that cannot be performed with this function. For details, see the notes and limitations described in this manual.

NOTE
Command programs, parameters, and variables are stored in nonvolatile memory in the CNC. Generally, the contents of memory are not lost by a power on/off operation. However, the contents of memory may be erased by mistake, or important data in nonvolatile memory may have to be erased because of recovery from a failure. To enable the restoration of data as soon as possible if such a situation arises, always make a backup of the data.
1.2 WARNINGS AND CAUTIONS RELATING TO THE CNC SCREEN DISPLAY FUNCTION

Warnings and cautions relating to the CNC screen display function are explained in this manual. Before using the function, read this manual thoroughly to become familiar with the provided Warnings, Cautions, and Notes. The following section, “Other Cautions That Must Be Read,” provides points that are not explained in this manual, but must be noted when you use the CNC screen display function. Be sure to read the section before using the CNC screen display function.

1.3 OTHER CAUTIONS THAT MUST BE READ

This section provides points to be noted when you use the CNC screen display function. Be sure to read the following before using the CNC screen display function.

⚠️ CAUTION

1. This manual does not explain in detail those operations and parameters that vary from one CNC model to another and which vary with options. For an explanation of such operations and parameters, refer to the relevant CNC manual and the manual supplied by the machine tool builder.

2. This manual describes as many reasonable variations in usage as possible. It cannot address every combination of features, options, and commands that should not be attempted. If a particular combination of operations is not described, it should not be attempted.
Thank you for purchasing the FANUC Open CNC CNC screen display function.

This software program, FANUC Open CNC CNC screen display function (hereafter referred to as the CNC screen display function), serves the purpose of implementing display and operation similar to those in a CNC in the Series 16i/18i/21i, Series 30i/31i/32i, Power Mate i, Series 0i-B/C, Series 15i, or Series 15-B. This software is intended for any of the following: a personal computer connected using a high-speed serial bus to a CNC in the Series 160i/180i/210i, Series 300i/310i/320i, Power Mate i, Series 0i-B/C, Series 150i, or Series 150-B; a personal computer connected via an Ethernet to a CNC in the Series 16i/18i/21i, Series 30i/31i/32i, Power Mate i, Series 0i-B, or Series 15i; a CNC in the Series 160i/180i/210i-A with the personal computer function; a CNC in the Series 160is/180is/210is; and a CNC in the Series 300is/310is/320is.

The CNC screen display function is supported by Microsoft® Windows® 95, Microsoft® Windows® 98, Microsoft® Windows NT® 4.0, Microsoft® Windows® 2000 Professional, Microsoft® Windows® XP Professional, or Microsoft® Windows® CE 2.0/2.12/3.0/.NET™ 4.1/.NET™ 4.2. This manual does not explain the basic common operations of Windows. Users who are using Windows for the first time should read the manuals on Windows first to become familiar with the basic operation of Windows.

Read this manual thoroughly to ensure the correct use of the CNC screen display function.

⚠️ CAUTION
FANUC holds the copyrights on this software product and associated manuals and other documents. Only one backup copy of this software product is permitted. Reproduction for other purposes is not allowed. This software can be installed on one computer only.

The CNC screen display function uses the following product for which copyright is held by Microsoft Corporation:
- Microsoft® Windows® Visual C++™

Microsoft, Windows, and Windows NT are registered trademarks of Microsoft Corporation. Visual C++ and .NET are registered trademarks of Microsoft Corporation.
1.1 FEATURES AND LIMITATIONS OF THE CNC SCREEN DISPLAY FUNCTION

The CNC screen display function has the following features:

**Features**

- This function enables the same display and operation as for the Series 16i/18i/21i, Series 30i/31i/32i, Power Mate i, Series 0i-B/C, Series 15i, or Series 15-B to be performed on Windows, providing a more user-friendly environment.

- This function enables user-created screens (screens created using C Executor, Macro Executor, PMC C) to be displayed.

**Limitations**

**Operating environment**

- This software can be used with any of the following:
  - Personal computer connected using a high-speed serial bus to a CNC in the Series 160i/180i/210i, Series 300i/310i/320i, Power Mate i, Series 0i-B/C, Series 150i, or Series 150-B
  - CNC in the Series 160i/180i/210i-A with the personal computer function
  - Personal computer connected via an Ethernet to a CNC in the Series 16i/18i/21i, Series 30i/31i/32i, Power Mate i, Series 0i-B/C, or Series 15i
  - CNC in the Series 160is/180is/210is
  - CNC in the Series 300is/310is/320is
  
  The software cannot be used with any other CNCs.

- This software supports the following CNCs:
  - HSSB version:
    - Series 160i-M/T/P/L/TP/W, Series 180i-M/T/P/W, Series 210i-M/T
    - Series 300i/310i/320i-A, Power Mate i-D/H,
    - Series 0i-MB/MB, Series 0i-MC/TC
    - Series 150i-M, Series 150-MB/MBMA/MBMA2
  - Ethernet version:
    - Series 16i-M/T/P/L/TP/W, Series 18i-M/T/P/W, Series 21i-M/T
    - Series 30i/31i/32i-A, Power Mate i-D/H, Series 0i-MB/MB, Series 0i-MC/TC
    - Series 15i-MA/MB
  - is series:
    - Series 160is/180is-M/T/W, Series 210is-M/T,
    - Series 300is/310is/320is-A
• This software for the Series 160is/180is/210is or Series 300is/310is/320is can not be used on a commercial Windows CE.

(2) Display

Use the personal computer in more than 256-color display mode.

• The CNC screen display function supports three types of resolutions, 640 × 480 dots (VGA), 800 × 600 dots (SVGA), and 1,024 × 768 dots (XGA). Available resolutions vary with models and settings. Display cannot be achieved in a resolution greater than the monitor’s resolution.

• When the CNC side has a CNC-dedicated display that is not part of a personal computer system, the LCD and MDI keyboard on the CNC side are unavailable during the execution of the CNC screen display function unless the dual display function is provided.

• When the CNC is in graphic display mode (for example, a tool path is being drawn), executing the CNC screen display function does not produce a graphic display which is already drawn. Also when the CNC screen display function is terminated while graphic display is being performed on the CNC screen display function side, no graphic display is produced on the CNC side. Graphic display must be performed again on each side respectively.

• The boot screen cannot be displayed.

• When characters and graphics are overlaid on one another, composite colors cannot be displayed. One of the colors, that of the characters or that of the graphic, must be specified as the priority color. (The default color is that of the characters.)

• Color palette numbers 0 to 15 and 240 to 255 are unavailable because they are reserved by Windows. Therefore, when a screen created in 256-color mode is displayed with the CNC screen display function, the colors corresponding to these color palette numbers are not displayed correctly.

• Screen programs created with the C Executer must be recompiled by using a library supporting the CNC screen display function supplied by FANUC. (Series 0r-B/C or Series 150-B is not supported C language Executer function.)

• Animated simulation for the Super CAP T/Super CAPi T, CAPI, CAPII.Symbol CAPi T, Series 150-MFB/TFB, or a lathe system is not displayed properly.

• The Manual Guide T screen cannot be displayed.
• The CNC screen display function supports messages in English, Japanese, German, French, Italian, Spanish, and Portuguese. However, a Windows version of the desired language must be provided to display messages properly. (The CNC screen display is set according to the CNC display language.)

• When the CNC in the Series 160is/180is/210is or Series 300is/310is/320is is used, the display position cannot be moved.

(3) Operation

• The CNC screen display function supports only data input/output as a memory card utility. The type of data that can be input and output is the same as that of data the CNC can input to and output from a memory card. The functions below cannot be used.
  - Editing PMC ladder programs directly from a memory card (ladder edit card function)
  - Performing DNC operation from a memory card
  - Directly editing and running programs in a memory card (Series 30i)
  - Using Servo Guide by inserting a memory card into the slot

When the CNC side has a CNC-dedicated display that is not part of a personal computer system, or the CNC is of the stand-alone type, however, the ladder edit card function and Servo Guide function are enabled by inserting a memory card into the card slot of the CNC.

• When the personal computer is connected to a CNC in the Series 16i/18i/21i, and a disk drive of the personal computer is specified as the file input/output destination, specify C: as a drive letter if file operation libraries below are used with the C Executor.
  aux_file_mount Register a memory card
  aux_file_unmount Cancel registration of a memory card
  aux_file_memcinfo Obtain memory card status

When the personal computer is connected to a CNC in the Series 30i/31i/32i, Series 0i-B/C, Power Mate i, or Series 150i, data of applications created with the C Executor cannot be input or output. When the CNC side has a CNC-dedicated display or the CNC is of the stand-alone type, however, data can be input and output if the card slot of the CNC is specified as the file input/output destination.
• The CNC screen display function for the Series 300is/310is/320is does not contain the memory card utility function. The memory card utility function is factory-installed in Windows CE.NET OS and FANUC Standard Applications/Libraries. With the memory card utility function, it is possible to input and output data, directly edit and run programs, and execute the Servo Guide function. However, the CNC screen display function enables file input/output destination folders to be switched.

• Position compensation and cursor control on the touch panel or by the mouse cannot be performed. For an Ethernet connection, dragging by the mouse cannot be performed.

• Screen erasure is disabled. Use a function such as a screen saver function of the personal computer.

• When the CNC screen display function is terminated forcibly by using, for example, [Ctrl]+[Alt]+[Delete], the CNC cannot display the screen for about 30 seconds after termination. After forcibly terminating the CNC screen display function, wait at least 30 seconds until the CNC can display the screen, then restart the CNC screen display function. (Any attempt to restart the CNC screen display function immediately after its termination will result in no response.) In some cases with the Ethernet version, however, the CNC cannot display the screen for about three minutes after forcible termination. In such cases, wait at least three minutes until the CNC can display the screen, then restart the CNC screen display function.

• Only one CNC screen display function can be started per CNC. When a computer is connected using high-speed serial buses or via an Ethernet to establish connections to two or more CNCs, each CNC may have one window open for the CNC screen display function at the same time.

• Pressing the [shift] key solely cannot trigger the screen copy function.

• To switch to the loader screen on the Series 16i/18i/21i, use the [shift]+[help] ([shift]+[ESC]) keys.
1.2 CHECKING THE PRODUCT PACKAGE

This product package software consists of the following:

- System CD-ROM (for HSSB, version 2.7 or later)
  FANUC Open CNC CNC Screen Display Function
  (A02B-0207-K775)

- System CD-ROM (for Ethernet, version 2.0 or later)
  FANUC Open CNC CNC Screen Display Function
  (A02B-0207-K776)

- System floppy disks (for HSSB, version 2.6 or earlier)
  FANUC Open CNC CNC Screen Display Function
  (A02B-0207-K770#JP07)

- System floppy disks (for Ethernet, version 1.11 or earlier)
  FANUC Open CNC CNC Screen Display Function
  (A02B-0207-K772#ZZ07)

NOTE
Place an order for the product on CD-ROM when you are a first-time buyer.
The product is available only on CD-ROM for CNCs in the Series 30i/31i/32i or later.

- System CD-ROM (Series 300is/310is/320is-A)
  FANUC Open CNC CNC Screen Display Function
  (A08B-9110-J801#ZZ11)

- System floppy disks (Series 160is/180is/210is-B)
  FANUC Open CNC CNC Screen Display Function
  (A02B-0207-K774#ZZ07)

- System floppy disks (Series 160is/180is/210is-A)
  FANUC Open CNC CNC Screen Display Function
  (A02B-0207-K771#ZZ07)

NOTE
Read the Release Note (README.TXT), provided on the second floppy disk of this product package. It provides detailed information on this product package and information not described in the operator's manual.
1.3 ORGANIZATION OF THIS MANUAL

This manual has the following organization:

SAFETY PRECAUTIONS
Explain the general precautions which must be observed to ensure safety when using the CNC screen display function.

PREFACE
Briefly explains the features of the CNC screen display function. Also explains how to use this manual and provides other information on the usage of the CNC screen display function.

1. SETUP
Explain how to set up the environment for operating the CNC screen display function and to prepare the CNC screen display function for use.

2. OPERATION
Explain how to use the CNC screen display function.

3. SETTING
Explain how to switch from one language to another in the CNC screen display function, and how to change the keyboard assignment.

APPENDIX A
Explain the alarms that are generated during the execution of the CNC screen display function and the actions to be taken.
1.4 NOTATION CONVENTIONS

The following explains the notation conventions used in this manual:

- **Menu, command, and screen notations**

<table>
<thead>
<tr>
<th>Example</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>[File] menu</td>
<td>Menu names are enclosed in brackets [ ].</td>
</tr>
<tr>
<td>[Title bar]</td>
<td>Command names are enclosed in brackets [ ].</td>
</tr>
<tr>
<td>&lt;OK&gt; button</td>
<td>Command buttons on the display are enclosed in angle brackets &lt; &gt;.</td>
</tr>
</tbody>
</table>

- **Key notations and operation**

<table>
<thead>
<tr>
<th>Example</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Enter] key</td>
<td>Key names are enclosed in brackets [ ].</td>
</tr>
<tr>
<td>[Ctrl]+[Tab] keys</td>
<td>When keys are to be pressed and held down sequentially, the keys are indicated by connecting them with +, as shown to the left.</td>
</tr>
<tr>
<td>Direction keys</td>
<td>The [→], [←], [↑], and [↓] keys are collectively called the direction keys.</td>
</tr>
</tbody>
</table>

- **Mouse/touch panel operation notations**

<table>
<thead>
<tr>
<th>Example</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click</td>
<td>Press a mouse button, then release it immediately. On a touch panel, use a stylus to touch the touch panel, and then release the stylus immediately. This is also called tapping.</td>
</tr>
<tr>
<td>Double-click</td>
<td>Click a mouse button twice in quick succession. On a touch panel, use a stylus to tap the touch panel twice in quick succession. This is also called double-tapping.</td>
</tr>
<tr>
<td>Drag</td>
<td>Move the mouse while holding down a mouse button, then release the button at a desired location. On a touch panel, move a stylus while holding down it on the touch panel, and then release the stylus at a desired position.</td>
</tr>
</tbody>
</table>

- **Others**

<table>
<thead>
<tr>
<th>Example</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>is series</td>
<td>This indicates the display unit for a CNC in the Series 160is/180is/210is or Series 300is/310is/320is.</td>
</tr>
</tbody>
</table>
• Sample screens
  The screens shown in this manual are sample screens for a Series 16i CNC unless otherwise specified.
  The screens shown in this manual are merely examples. Note that the screen layouts and displayed file names may vary depending on the equipment being used.
  The sample screens shown in this manual are mainly taken from an environment where the product runs under Windows 95. Note that actual screens may differ from the samples depending on your OS.
# TABLE OF CONTENTS

**SAFETY PRECAUTIONS**

**PREFACE**

## 1 SETUP

1.1 SETUP (HSSB VERSION)

1.1.1 Operating Environment

1.1.2 Installing the CNC Screen Display Function

1.1.3 Repairing and Uninstalling the CNC Screen Display Function

1.2 SETUP (ETHERNET VERSION)

1.2.1 Operating Environment

1.2.2 Installing the CNC Screen Display Function

1.2.3 Repairing and Uninstalling the CNC Screen Display Function

1.3 SETUP (iS SERIES)

1.3.1 Operating Environment

1.3.2 Installing the CNC Screen Display Function

1.3.3 Uninstalling the CNC Screen Display Function

## 2 OPERATION

2.1 START AND TERMINATION (HSSB VERSION)

2.1.1 Starting the CNC Screen Display Function

2.1.2 Starting the CNC Screen Display Function (Multiple Connection)

2.1.3 Terminating the CNC Screen Display Function

2.2 START AND TERMINATION (ETHERNET VERSION)

2.2.1 Start

2.2.2 Start (Multiple Connection)

2.2.3 Termination

2.2.4 Termination by Means of the PMC Signal

2.3 START AND TERMINATION (iS SERIES)

2.3.1 Start

2.3.2 Termination

2.4 TYPES OF DISPLAYED SCREENS

2.5 INPUT FROM THE KEYBOARD

2.6 INPUT WITH THE MOUSE AND TOUCH PANEL

2.7 FUNCTION KEYS

2.8 DATA INPUT/OUTPUT
### TABLE OF CONTENTS

2.9  CLEARING ALARMS
2.10 COPYING SCREENS (is SERIES)
2.11 DISPLAYING VERSION INFORMATION

3  SETTING
3.1  SWITCHING BETWEEN LOCATIONS TO SAVE THE SETTINGS
3.2  SWITCHING BETWEEN DISPLAY LANGUAGES
3.3  SETTING SCREEN RESOLUTIONS
3.4  SETTING THE DISPLAY TIMING AT STARTUP
3.5  SETTING ANIMATED SIMULATION FOR TURNING
3.6  CHANGING KEYBOARD ASSIGNMENT

**APPENDIX**

A  ALARMS
B  ETHERNET VERSION COMMUNICATION LOG FUNCTION
1 SETUP

This chapter explains how to set up the environment for operating the CNC screen display function, and how to prepare the CNC screen display function for operation.
1.1 SETUP (HSSB VERSION)

This section describes information related to the setup of the HSSB version of the CNC screen display function.

See Section 1.2, "Setup (Ethernet Version)," for explanations about the setup of the Ethernet version of the CNC screen display function.

1.1.1 Operating Environment

The software operating environment for the CNC screen display function is as follows:

- **Computer**
  - Series 160i/180i/210i with the personal computer function
  - Personal computer attached to high-speed serial bus (connected to the Series 160i/180i/210i, Series 300i/310i/320i, Power Mate i, Series 0i-B/C, Series 150i, or Series 150-B)

- **Environmental requirements**
  - For Windows 95 / 98
    - Pentium 100 MHz or better processor
    - 16 MB of memory (minimum)
  - For Windows NT4.0
    - Pentium 120 MHz or better processor
    - 32 MB of memory (minimum)
  - For Windows 2000 Professional
    - Pentium 166 MHz or better processor
    - 64 MB of memory (minimum)
  - For Windows XP Professional
    - Pentium 300 MHz or better processor
    - 128 MB of memory (minimum)

- **Recommended operating environment**
  - For Windows 95 / 98
    - Pentium 120 MHz or better processor
    - 32 MB of memory (minimum)
  - For Windows NT4.0
    - Pentium 150 MHz or better processor
    - 64 MB of memory (minimum)
  - For Windows 2000 Professional
    - Pentium 200 MHz or better processor
    - 96 MB of memory (minimum)
  - For Windows XP Professional
    - Pentium 500 MHz or better processor
    - 128 MB of memory (minimum)
• Display
  - Resolution: $640 \times 480$ or higher resolution
    For Windows XP Professional: $800 \times 600$ or higher resolution
  - Color: 256 colors or more (16-color mode cannot be used)
    For Windows XP Professional: 65,000 colors or more

• Required hard disk space
  - 20 MB or more

NOTE
1 The CNC screen display function runs under Windows 95 / 98, Windows NT 4.0, Windows 2000 Professional, or Windows XP Professional.
2 Maximum performance sometimes cannot be achieved depending on the type, performance, and usage of the personal computer.
3 As with other Windows applications, this function is subject to restrictions when operating in multitasking mode. That is, the CNC screen display function affects the execution speed of other applications, and other applications affect the execution speed of the CNC screen display function.
1.1.2 Installing the CNC Screen Display Function

This subsection explains how to install the CNC screen display function.

**NOTE**

Before the CNC screen display function can be installed, operations such as driver installation and setting of the following drivers must be performed according to the operating environment.

- HSSB device driver
- MDI keyboard driver (PANEL i and Series 160i/180i/210i with Personal Computer Function)

For more information, see the Release Note (README.TXT/READMEJ.TXT) provided on the driver library CD-ROM (A02B-0207-K737), floppy disks (A02B-0207-K730#ZZ07), or PANEL i drivers disk CD-ROM (A08B-0084-K790).

**Procedure for installing the CNC screen display function**

1. Insert the system CD-ROM (A02B-0207-K775) into the CD-ROM drive or insert Disk1 of the system floppy disks (A02B-0207-K770#JP07) into the floppy disk drive.
2. Select the [Start] menu.
3. Select [Run...].
4. Enter `<drive-name>\SETUP`, and select the <OK> button.
   (<drive-name> is the name of the CD-ROM drive or floppy disk drive.)
5. Install the CNC screen display function according to the displayed messages.
1.1.3 Repairing and Uninstalling the CNC Screen Display Function

This subsection explains how to repair and uninstall the CNC screen display function.

Procedure for repairing and uninstalling the CNC screen display function

1. Choose the [Start] menu.
2. Choose [Control Panel].
3. Execute [Add/Remove Programs].

The Add/Remove Programs screen appears.

4. Choose the CNC Screen Display Function.
5. Choose the <Change/Remove...> button.

The Maintenance Dialog screen appears.
The Maintenance Dialog screen allows you to perform the following:

“Modify”  Install or uninstall components.
“Repair”  Reinstall the CNC screen display function.
“Remove”  Uninstall the CNC screen display function.

You need not select “Modify” because the CNC screen display function contains only one component.

6. Select the desired action and choose the <Next> button.

When you select “Remove”, the uninstall function starts, prompting you to choose whether you want to uninstall the program.

To uninstall the program, choose the <OK> button.

When the CNC screen display function has been uninstalled normally, the function is deleted from the Windows program menu.
1.2 SETUP (ETHERNET VERSION)

This section describes information related to the setup of the Ethernet version of the CNC screen display function.

See Section 1.1, "Setup (HSSB Version)," for explanations about the setup of the HSSB version of the CNC screen display function.

1.2.1 Operating Environment

The software operating environment for the CNC screen display function is as follows:

- Environmental requirements
  - For Windows 95 / 98
    - Pentium 100 MHz or better processor
    - 16 MB of memory (minimum)
  - For Windows NT4.0
    - Pentium 120 MHz or better processor
    - 32 MB of memory (minimum)
  - For Windows 2000 Professional
    - Pentium 166 MHz or better processor
    - 64 MB of memory (minimum)
  - For Windows XP Professional
    - Pentium 300 MHz or better processor
    - 128 MB of memory (minimum)

- Recommended operating environment
  - For Windows 95 / 98
    - Pentium 120 MHz or better processor
    - 32 MB of memory (minimum)
  - For Windows NT4.0
    - Pentium 150 MHz or better processor
    - 64 MB of memory (minimum)
  - For Windows 2000 Professional
    - Pentium 200 MHz or better processor
    - 96 MB of memory (minimum)
  - For Windows XP Professional
    - Pentium 500 MHz or better processor
    - 128 MB of memory (minimum)

- Display
  - Resolution: 640 × 480 or higher resolution
    - For Windows XP Professional: 800 × 600 or higher resolution
  - Color: 256 colors or more (16-color mode cannot be used)
    - For Windows XP Professional: 65,000 colors or more
• Required hard disk space
  - 20 MB or more

**NOTE**

1. The CNC screen display function runs under Windows 95/98, Windows NT 4.0, Windows 2000 Professional, or Windows XP Professional.

2. Maximum performance sometimes cannot be achieved depending on the type, performance, and usage of the personal computer.

3. As with other Windows applications, this function is subject to restrictions when operating in multitasking mode. That is, the CNC screen display function affects the execution speed of other applications, and other applications affect the execution speed of the CNC screen display function.

4. The Ethernet version of the CNC screen display function is implemented through socket communication (TCP/IP communication) with a FANUC Ethernet board or FANUC Fast Ethernet board. Before using the function, refer to the relevant manuals to check the following items.
   - TCP/IP setting in the personal computer
   - Setting of the FANUC Ethernet board and FOCAS1 (DNC1)/Ethernet function in the CNC
   - Network connection between the personal computer and CNC
   - For Series 16i/18i/21i/Power Mate i, Series 0i-B/C, and Series 15i
     FANUC Ethernet Board OPERATOR’S MANUAL (B-63354EN)
     FANUC Fast Ethernet Board / Fast Data Server OPERATOR’S MANUAL (B-63644EN)
   - For Series 30i/31i/32i
     FANUC Fast Ethernet / Fast Data Server OPERATOR’S MANUAL (B-64014EN)
1.2.2 Installing the CNC Screen Display Function

This subsection explains how to install the CNC display function.

Procedure for installing the CNC screen display function

1. Insert the system CD-ROM (A02B-0207-K776) into the CD-ROM drive or insert Disk1 of the system floppy disks (A02B-0207-K772#ZZ07) into the floppy disk drive.
2. Choose the [Start] menu.
3. Choose [Run...].
4. Enter <drive-name>::SETUP, and choose the <OK> button. (<drive-name> is the name of the CD-ROM drive or floppy disk drive.)
5. Install the CNC screen display function according to the display messages.
1.2.3 Repairing and Uninstalling the CNC Screen Display Function

This subsection explains how to repair and uninstall the CNC screen display function.

Procedure for repairing and uninstalling the CNC screen display function

1. Choose the [Start] menu.
2. Choose [Control Panel].
3. Execute [Add/Remove Programs].

The Add/Remove Programs Properties screen appears.

4. Choose the CNC Screen Display Function (Ethernet).
5. Choose the <Add/Remove...> button.

The Maintenance Dialog screen appears.
The Maintenance Dialog screen allows you to perform the following:

“Modify”  Install or uninstall components.
“Repair”  Reinstall the CNC screen display function.
“Remove” Uninstall the CNC screen display function.

You need not select “Modify” because the CNC screen display function contains only one component.

6. Select the desired action and choose the <Next> button.

When you select “Remove”, the uninstall function starts, prompting you to choose whether you want to uninstall the program.

To uninstall the program, choose the <OK> button.

When the CNC screen display function has been uninstalled normally, the function is deleted from the Windows program menu.
1.3 SETUP (is SERIES)

This section provides information related to the setup of the CNC screen display function for CNCs in the is series (Series 160is/180is/210is or Series 300is/310is/320is).

1.3.1 Operating Environment

This software is intended only for use with CNCs in the Series 160is/180is/210is or Series 300is/310is/320is.

NOTE

Like other Windows applications, this function runs in multitasking mode and subject to operational constraints. This means that the CNC screen display function affects the execution speed of another application, which in turn affects the execution speed of the CNC screen display function.
1.3.2 Installing the CNC Screen Display Function

The CNC screen display function is preinstalled in the following CNCs in the Series 160is/180is/210is or Series 300is/310is/320is: CNC of the LCD-mounted type that is installed on the main board or CNC of the stand-alone type that is connected with the HSSB. Normally, installation is not required. Use the following procedure to install the function for upgrading.

Procedure for installing the CNC screen display function

1. Copy the executable of the CNC screen display function to the root folder of the ATA card.

For Series 160is/180is/210is
(a) Copy the compressed file of the CNC screen display function to an empty folder in a development personal computer. The file is a self-extracting compressed file. The name of the compressed file depends on your OS and CNC model as shown below.
   - Series 160is/180is/210is-A (A02B-0207-K771#ZZ07)
     Windows CE2.00: WINCE200.EXE
     Windows CE2.12: WINCE212.EXE
   - Series 160is/180is/210is-B (A02B-0207-K774#ZZ07)
     CSDFWCE300.EXE
(b) Run the copied file. The file uncompresses the compressed contents.
(c) Copy the restored Setupis.exe file and CNCScrn folder to the root folder of the ATA card.

For Series 300is/310is/320is
Copy the contents (file and folder) of the CD-ROM to the root folder of the ATA card.

2. Turn on the power to the CNC.
3. Insert into the PCMCIA slot of the CNC the ATA card containing the copy of the file.
4. Open My Computer on the desktop.
5. Ensure that the ATA card is automatically recognized as Storage Card2.


7. With the check box selected for the CNCScrn program to be installed, press the “OK” button or “INPUT” key.

8. When the installation completes, the message below appears. Then, remove the ATA card, turn the power off and then back on.

When you insert the ATA card containing the copy of the program and turn on the power to the CNC, Setupis.exe starts automatically.

**NOTE**
Do not turn off the power to the CNC while Setupis.exe is running. If you turn off the power to the CNC during the copying, the data in the compact flash memory may be corrupted.
1.3.3 Uninstalling the CNC Screen Display Function

To uninstall the CNC screen display function, remove the following folder.

\Storage Card\FANUC\CNCScrn
This chapter explains how to operate the CNC screen display function.
2.1 START AND TERMINATION (HSSB VERSION)

This section explains how to start and terminate the HSSB version of the CNC screen display function, and explains the points to be noted when the function is started.

See Section 2.2, "Start and Termination (Ethernet Version)," for explanations about how to start and terminate the Ethernet version of the CNC screen display function.

2.1.1 Starting the CNC Screen Display Function

The following explains the procedure for starting the CNC screen display function from the Windows start menu, and explains the points to be noted when you start the function.

Procedure

1. Choose the [Start] menu.
2. Choose the [Programs] command.
3. Choose the **CNC Screen Display Function** command.
The following CNC Screen Display Function screen appears:

Example 1.

CNC screen display function on the Series 160i/180i/210i

Example 2.

CNC screen display function on the Series 300i/310i/320i

In a CNC in the Series 160i/180i/210i or Series 0i-B/C, you can use the command line argument /M to specify a text file containing strings you want to display on the CNC screen during startup of the CNC screen display function. This allows you to display any message on the CNC screen. A message can be displayed in a field of 32 characters by 8 lines, and can contain up to 256 characters. The format of the command line specification is as follows.
Characters that cannot be displayed on the CNC are replaced with spaces.

4. When the display has the same resolution as the CNC screen, clear [Title bar] in the submenu of [View] on the menu bar to hide the title bar, thereby maximizing the CNC screen on the display.

To hide the Windows taskbar, select [Display above task bar] in the submenu of [View] on the menu bar.

5. To display the title bar, perform the following:
   When using the mouse : Click the right button.
   When using the full keyboard : [Shift]+[F10]
   When using the MDI keyboard : [SHIFT]+[GRAPH]

A pop-up menu, shown below, appears. Choose [Title bar].
NOTE
1 When the CNC screen display function is started on the Series 160i/180i/210i; or Series 0i-B/C, the CNC display screen to be displayed is determined according to the following CNC parameters:
   CNC parameters: Nos. 3198 and 3199
   (CNC parameter for enabling the above parameters: Bit 6 of parameter No. 3103)
When the CNC screen display function is started for the Power Mate i, the position display screen appears.
When the CNC screen display function is started on the Series 300i/310i/320i, Series 150i, or Series 150-B, the screen that was selected on the CNC before this function is started remains displayed. Likewise, when the CNC screen display function is ended, the screen that was displayed by this function is displayed on the CNC. Note that when the PMC screen is displayed, the screen of the CNC that was displayed before the PMC screen is displayed is displayed. Also, when the CNC screen display function is started or ended with the help menu or multi-teaching function pop-up menu displayed, these screens are cleared.
2 When a resolution is larger than the CNC screen size, the title bar is always shown (the menu item [Title bar] is unavailable).
3 To perform dual display, set the following parameter:
   CNC parameter: Set bit 7 of parameter No. 3206 to 1.
   The option for the dual display function must be provided for a CNC. The dual display function is only supported by CNCs in the Power Mate i.
2.1.2 Starting the CNC Screen Display Function (Multiple Connection)

The CNC screen display function allows one personal computer to be used for operating up to eight CNCs (Series 16i/18i/21i, Series 0i-B/C, Series 30i/31i/32i, Power Mate i, Series 15i, or Series 15-B) when these CNCs are connected to the personal computer via high-speed serial bus. The response to manipulation for display becomes slower as the number of connected CNCs increases.

- Starting the function
  When more than one CNC is connected or can be connected, the CNC screen display function can be executed more than once at the same time. In this case, each time the CNC screen display function is started, the following CNC select screen appears:

  The buttons have the following meanings:
  
  Exec. : Executes the CNC screen display function. When the CNC screen display function is already running, the running CNC screen display function is displayed on top.
  Stop : Stops the current CNC screen display function.
  Close : Terminates the CNC screen display function.
## Explanation of the list

The list contains the following information:

- **General format of the list**
  
  **CNC No.** = 01  160/180/210  **Connecting**

  **Connection status**
  - Disconnect
  - Connecting
  - Executing

- **CNC model**
  - 160/180/210 (Series 160i/180i/210i)
  - 0i-B (Series 0i-B)
  - 300i/310i/320i (Series 300i/310i/320i)
  - 160i/180i-W (Series 160i/180i-W)
  - Power Mate-i (Power Mate i)
  - 150i (Series 150i)
  - 150-B (Series 150-B)

- **CNC number (00 to 07)**

### (1) CNC number

The number of a CNC that can be connected is indicated.

### (2) CNC model

The model of the CNC that is connected or which can be connected is indicated.

### (3) Connection status

**Disconnect** :

The power to the CNC is off, or the cable is not connected correctly.

In this state, neither the **Exec.** button nor the **Stop** button can be chosen.

**Connecting** :

The CNC is connected correctly.

Choosing the **Exec.** button executes the CNC screen display function.

The **Stop** button cannot be chosen.

**Executing** :

The CNC screen display function is running.

Choosing the **Exec.** button displays the currently executed CNC screen on top.

Choosing the **Stop** button stops the CNC screen display function. When this button is chosen, the connection status in the list changes from Executing to Connecting.
NOTE
When a CNC in the Disconnect status has been connected correctly, perform the following operation. Then, the status indication changes to Connecting, and the [Execute] button can be chosen.
(1) With the mouse, click an arbitrary CNC in the list.
(2) With the cursor keys, select another item in the list.

The CNC to be connected can be specified using an argument on the command line. When this argument is used, the above Select CNC screen does not appear. The format of the command line specification is as follows:

```
CNCSCRN /NODE = <CNC-number>
```
2.1.3 Terminating the CNC Screen Display Function

The following explains how to terminate the CNC screen display function. As explained below, there are several termination methods. You can use any of these methods to terminate the CNC screen display function.

Operation 1
Terminating from a pop-up menu
Click the right button of the mouse on the screen of the CNC screen display function. A pop-up menu as shown below appears. Choose [Exit].

```
  Data input/output..  Title bar
  Display above task bar  Function key
  Alarm Clear  About
           Minimize

  Exit
```

Operation 2
Terminating from the menu bar
Choose [Exit] from the submenu of [File].

```
CNC Screen Display Function
  File  View  Option  Help
  Data Input/Output.

  Exit
```

Operation 3
Terminating from the title bar
Click ✗

```
  Exit
```

Operation 4
Terminating from the keyboard
- On the PS/2 keyboard or USB full keyboard, press [Alt]+[F4].
- On the MDI keyboard:
  - Series 160i/180i/210i
    Press the unlabeled key (or [FAPT]) + [SHIFT] + [DELETE].
  - Series 300i
    Press [ALT] + [SHIFT] + [DELETE].
If the function is terminated due to a broken communication rather than by any of the above methods, the message below appears.

To suppress this message, clear [Display communication error] in the submenu of [View].

NOTE

During the termination processing for the CNC screen display function, the following message appears:

If the CNC screen display function is restarted while this message is being displayed, the CNC screen display function may operate abnormally. When restarting the CNC screen display function, restart the function after the above message disappears.
2.2 START AND TERMINATION (ETHERNET VERSION)

This section explains how to start and terminate the Ethernet version of the CNC screen display function, and explains the points to be noted when the function is started.

See Section 2.1, "Start and Termination (HSSB Version)," for explanations about how to start and terminate the HSSB version of the CNC screen display function.

2.2.1 Start

The following explains the procedure for starting the CNC screen display function from the Windows start menu, and explains the points to be noted when the function is started.

Procedure

1. Choose the [Start] menu.
2. Choose the [Programs] command.
3. Choose CNC Screen Display Function (Ethernet) to start it.

4. When the CNC screen display function is started, the following screen appears to specify the destination:

   ![Screen Display Function Start Menu]

   ![Destination Specification Screen]
When the function is started for the first time or the is selected, the screen changes to the following:

On this screen, enter the following items.

**Host**: Specify a host name (such as "CNC1") or an IP address (such as "190.0.2.31").

**Port no.**: Specify the port number for the FOCAS1 (DNC1)/Ethernet function.

**Timeout**: Specify a timeout value for graphic data transmission/reception in seconds. Entering 0 disables timeout processing, causing an infinite wait.

A host name and port number can be specified using arguments on the command line. When these arguments are used, the above screen to specify the destination does not appear. The format of the command line specification is as follows:

```
CNCSCRNE /H=<host-name>:<port-number>
/T=<timeout-value (by default, 30)>
```

The /H and /T arguments can be specified at the same time.

You can also specify a host name or IP address, a port number and timeout value by using a text file (with the extension .FSDF) containing the settings of these items. The format of the FSDF file data is as follows:

```
(Line 1) IP= <host-name>:<port-number>
   <timeout-value (by default, 30)>
(Line 2) Name=<destination-machine-name (currently unused)>

Example:
IP = 192.168.2.32:8193 30
Name = FANUC ROBODRILL α-T14iC
```

The CNC screen display function has been associated with the FSDF file during setup. You can start the CNC screen display function by double-clicking the FSDF file, or by right-clicking the FSDF file and then choosing [Open] from a menu that appears.
The format of the command line specification of the FSDF file is as follows:

\[
\text{CNCSCRNE} \ <\text{FSDF file-name (full path)}> 
\]

5. Choosing the \textbf{OK} button causes the screen to change to the following:

\begin{center}
\includegraphics[width=\textwidth]{image}
\end{center}

\textbf{NOTE}

It may take several minutes for the Ethernet version to start. Choosing \textbf{Cancel} discontinues the start sequence.

When the CNC is connected successfully, the CNC Screen Display Function screen appears.

\textbf{Example 1 For Series 16i/18i/21i}
Example 2  For Series 30i/31i/32i

In a CNC in the Series 16i/18i/21i or Series 0i-B/C, you can use the command line argument /M to specify a text file containing strings you want to display on the CNC screen during startup of the CNC screen display function. This allows you to display any message on the CNC screen. A message can be displayed in a field of 32 characters by 8 lines, and can contain up to 256 characters. The format of the command line specification is as follows.

```
CNCSCRNE /M=<file-name (full path)>
```

The /M, /H, and /T arguments can be specified at the same time. Characters that cannot be displayed on the CNC are replaced with spaces.

5. When the display has the same resolution as the CNC screen, clear [Title bar] in the submenu of [View] on the menu bar to hide the title bar, thereby maximizing the CNC screen on the display.

To hide the Windows taskbar, select [Display above task bar] in the submenu of [View] on the menu bar.
6. To display the title bar, perform the following:
   When using the mouse : Click the right button.
   When using the keyboard : [Shift]+[F10]

   A pop-up menu, shown below, appears. Choose [Title bar].
NOTE
1 When the CNC screen display function is started in the Series 16i/18i/21i or Series 0i-B/C, the CNC display screen to be displayed is determined according to the following CNC parameters:
CNC parameters: Nos. 3198 and 3199
(CNC parameter for enabling the above parameters: Bit 6 of parameter No. 3103)
When the CNC screen display function is started for the Power Mate i, the position display screen appears.
When the CNC screen display function is started on the Series 30i/31i/32i or Series 15i, the screen that was selected on the CNC before this function is started remains displayed. Likewise, when the CNC screen display function is ended, the screen that was displayed by this function is displayed on the CNC. Note that when the PMC screen is displayed, the screen of the CNC that was displayed before the PMC screen is displayed is displayed. Also, when the CNC screen display function is started or ended with the help menu or multi-teaching function pop-up menu displayed, these screens are cleared.
2 When a resolution is larger than the CNC screen size, the title bar is always shown (the menu item [Title bar] is unavailable).
3 To perform dual display, set the following parameter:
CNC parameter: Set bit 7 of parameter No. 3206 to 1.
The option for the dual display function must be provided for a CNC. The dual display function is only supported by CNCs in the Series 16i/18i/21i, Series 0i-B/C, or Power Mate i.
2.2.2 Start (Multiple Connection)

The Ethernet version of the CNC screen display function allows one personal computer to be used for operating two or more CNCs connected over an Ethernet network (the maximum number of connectable CNCs is determined according to the related Ethernet limitation). The response to manipulation for display becomes slower as the number of connected CNCs increases.

- Starting the function
  This function can be started using the same starting procedure described in Subsection 2.2.1. Specify the host name (such as "CNC1" or "CNC2") or IP address that matches the CNC to be connected.

- Simultaneous Ethernet and high-speed serial bus connection
  It is possible to run the CNC screen display function for a CNC connected via the high-speed serial bus and that for the CNC connected via the Ethernet simultaneously on a single personal computer. To set up the functions for this purpose, perform the setting procedures described in both Section 1.1, "Setup (HSSB Version)," and Section 1.2, "Setup (Ethernet Version)." To start and terminate the functions, follow the procedures described in Section 2.1, "Start and Termination (HSSB Version)," and Section 2.2, "Start and Termination (Ethernet Version)."
2. OPERATION

2.2.3 Termination

The following explains how to terminate the CNC screen display function.
As explained below, there are several termination methods. You can use any of these methods to terminate the CNC screen display function.

Operation 1
Terminating from a pop-up menu
Click the right button of the mouse on the screen of the CNC screen display function. A pop-up menu as shown below appears. Choose [Exit].

Operation 2
Terminating from the menu bar
Choose [Exit] from the submenu of [File].

Operation 3
Terminating from the title bar
Click  

Operation 4
Terminating from the keyboard
Press [Alt]+[F4].

If the function is terminated due to a broken communication rather than by any of the above methods, the message below appears.
To suppress this message, clear [Display communication error] in the submenu of [View].

NOTE
During the termination processing for the CNC screen display function, the following message appears:

If the CNC screen display function is restarted while this message is being displayed, the CNC screen display function may operate abnormally. When restarting the CNC screen display function, restart the function after the above message disappears.
2.2.4 Termination by Means of the PMC Signal

The following explains how to terminate the CNC screen display function by means of the PMC signal.

Not using this function does not influence the operation of the CNC screen display function. Use it as required.

Turning on a specified machine signal terminates the CNC screen display function. To specify the machine signal, follow the procedure below.

1. Choose the [Close Signal...] from the submenu of [Option] in the menu bar.

2. The Close Signal dialog box appears.

3. Enter the target PMC signal in the Signal on host text box, using the following format, then choose the button.

   `<signal-address>.<bit-position>`  Example)  X0004.7

The close signal can be specified also using an argument on the command line.

The format of the command line specification is as follows:

   `CNCSCRNE /S=<signal-address>.<bit-position>`

The /H, /T, /M, and /S arguments can be specified simultaneously.
NOTE

1. The setting of the machine signal is preserved. It is impossible to start the CNC screen display function if the set signal is kept turned on with the PMC sequence program.

2. The PMC signal can be used to terminate only the Ethernet version of the CNC screen display function. It is not supported for the HSSB version of the CNC screen display function.
2.3  START AND TERMINATION (is series)

This section explains how to start and terminate the CNC screen display function for is series (Series 160is/180is/210is or Series 300is/310is/320is), and explains the points to be noted when the function is started.

2.3.1  Start

The following explains the procedure for starting the CNC screen display function for a CNC of the LCD-mounted type that is installed on the main board or a CNC of the stand-alone type that is connected with the HSSB, and explains the points to be noted when you start the function.

Procedure

1. Open the \Storage Card\FANUC\CNCScrn folder.

2. Start CNCScrn.exe.

With NCBOOTis (Series 160is/180is/210is) or NCBOOT32 (Series 300is/310is/320is), the CNC screen display function can also be automatically started at power-on. For more information, refer to any of the following operator’s manuals:
- Series 160is/180is/210is-A (A02B-0207-K733#ZZ07) NCBOOTisj.doc
- Series 160is/180is/210is-B (A02B-0207-K736#ZZ07) NCBOOTisj.doc
- Series 300is/310is/320is-A (A08B-9110-J702#ZZ11) NCBOOT32.doc

Showing the title bar

To show the title bar, perform the following:

1. Press the keys below to display the [View] menu.
   - For Series 160is/180is/210is: [Unlabeled key] + [V]
   - For Series 300is/310is/320is: [ALT] + [V]

2. Select [Title bar] in the [View] menu.
Hiding the Windows taskbar

To hide the Windows taskbar, perform the following:

1. Press the keys below to display the [View] menu.
   - For Series 160is/180is/210is: [Unlabeled key] + [V]
   - For Series 300is/310is/320is: [ALT] + [V]

2. Select [Display above task bar] in the [View] menu.

NOTE

When the CNC screen display function is started on the Series 160is/180is/210is, the CNC display screen to be displayed is determined according to the following CNC parameters:
- CNC parameters: Nos. 3198 and 3199
- (CNC parameter for enabling the above parameters: Bit 6 of parameter No. 3103)

When the CNC screen display function is started on the Series 300is/310is/320is, the screen that was selected on the CNC before this function is started remains displayed. Likewise, when the CNC screen display function is ended, the screen that was displayed by this function is displayed on the CNC. Note that when the PMC screen is displayed, the screen of the CNC that was displayed before the PMC screen is displayed is displayed. Also, when the CNC screen display function is started or ended with the help menu or multi-teaching function pop-up menu displayed, these screens are cleared.
2.3.2 Termination

The following explains how to terminate the CNC screen display function.
To terminate the CNC screen display function, the same procedure can be used for a CNC of the LCD-mounted type that is installed on the main board, a CNC of the stand-alone type that is connected with the HSSB, and a CNC that is connected via an Ethernet.

Procedure

1. Press the keys below to display the [File] menu.
   For Series 160is/180is/210is: [Unlabeled key] + [F]
   For Series 300is/310is/320is: [ALT] + [F]

2.4 TYPES OF DISPLAYED Screens

This section explains types of displayed screens.

The CNC screen display function can display the following types of screens.

The type of a screen cannot be changed as a rule because it depends on whether a CNC has a CNC-dedicated display and which type the display is.

- 10.4-inch display (12-soft key type)

A standard screen image is shown above. This type of screen appears when the CNC side has a CNC-dedicated display for the 10.4-inch image view or when the CNC does not have a CNC-dedicated display.

The screen resolution is 640 × 480 dots (VGA). You can obtain an enlarged screen view of 800 × 600 dots (SVGA) or 1,024 × 768 dots (XGA) by setting either of the resolutions. See Section 3.3, “Setting Screen Resolutions,” for an explanation of how to set a resolution.

When a CNC in the Series 300is/310is/320is has a 15-inch display, screens can be displayed in 10.4-inch mode by setting the following parameter:

Set bit 7 of CNC parameter No. 13115 to 1.
NOTE
1 The SVGA/XGA enlarged view capability for a 10.4-inch display can be used for CNCs in the Series 16i/18i/21i, Series 160i/180i/210i, Series 0i-B/C, Series 30i/31i/32i, and Series 300i/310i/320i. The SVGA enlarged view capability can be used for CNCs in the Series 160is/180is/210is and Series 300is/310is/320is. The other models do not support the enlarged view capability. The option for the XGA/SVGA enlarged view capability of the CNC screen display function must be provided for a CNC in the Series 16i/18i/21i, Series 160i/180i/210i, Series 160is/180is/210is, or Series 0i-B/C.

2 You can only obtain SVGA/XGA-size enlarged views of standard CNC/PMC screens (including screens created using the C Executor, Macro Executor, or PMC C) and MANUAL GUIDE i screens. Interactive screens other than MANUAL GUIDE i screens cannot be displayed.

3 Solid shapes may be distorted on an SVGA/XGA-size enlarged view of any of user-created screens (including screens created using the C Executor, Macro Executor, or PMC C).

4 Fonts of displayed characters depend on which screen size is used, VGA, SVGA, or XGA.

5 An XGA enlarged view does not fill the entire screen. This view is defined by a black frame as shown below, which has a total width of 24 dots in the top and bottom borders and a total width of 32 dots in the left and right borders.
• 9-inch display (7-soft key type)

This type of screen appears when the CNC side has a CNC-dedicated display for the 9-inch image view. Examples of such display are 9-inch CRT displays, 7.2-inch LCDs (monochrome), and 8.4-inch LCDs. The screen resolution is $640 \times 480$ dots (VGA).

The 9-inch view is not supported in a CNC in the Series 150-B, Series 15i, or Series 150i.

• 15-inch display
This type of screen can be displayed only for a CNC in the Series 30i/31i/32i, Series 300i/310i/320i, or Series 300is/310is/320is. The screen appears when the CNC side has a CNC-dedicated display for the 15-inch image view. If the CNC is of the stand-alone type and does not have a CNC-dedicated display, screens can be displayed in 15-inch mode by setting the following parameter:

Set bit 0 of CNC parameter No. 13114 to 1.

The screen resolution is 1,024 × 768 dots (XGA).

**NOTE**

If the resolution of the CNC screen display function is higher than that of the monitor of your personal computer, screens cannot be displayed properly. In this case, regions lying offscreen are clipped and not displayed.
2.5 INPUT FROM THE KEYBOARD

This section explains the key input method.

- Input from the MDI keyboard (Series 160i/180i/210i,
  Series 160is/180is/210is, Series 300i/310i/320i,
  Series 300is/310is/320is, Series 0i-B/C, and Series 150i)
  The CNC MDI keys, with some exceptions, can be used in the
  manner described in the CNC operator’s manual.

For the CNC screen display function, the key codes for another
personal computer may be assigned to the MDI keys. To perform
MDI key operations below, use the corresponding alternative
keys.

For Series 160i/180i/210i, Series 160is/180is/210is, or
Series 0i-B/C

<table>
<thead>
<tr>
<th>[MDI key]</th>
<th>Key used in the CNC screen display function</th>
<th>Alternative key of function key</th>
</tr>
</thead>
<tbody>
<tr>
<td>[CUSTOM]</td>
<td>[Ctrl]</td>
<td>[SHIFT]+[POS]</td>
</tr>
<tr>
<td>Unlabeled (or [FAPT])</td>
<td>[Alt]</td>
<td>[SHIFT]+[PROG]</td>
</tr>
</tbody>
</table>

For Series 300i/310i/320i or Series 300is/310is/320is

<table>
<thead>
<tr>
<th>[MDI key]</th>
<th>Key used in the CNC screen display function</th>
<th>Alternative key of function key</th>
</tr>
</thead>
<tbody>
<tr>
<td>[SHIFT]+[1]</td>
<td>!</td>
<td>[SHIFT]+[F1]</td>
</tr>
<tr>
<td>[SHIFT]+[2]</td>
<td>*</td>
<td>[SHIFT]+[F2]</td>
</tr>
<tr>
<td>[SHIFT]+[3]</td>
<td>^</td>
<td>[SHIFT]+[F3]</td>
</tr>
<tr>
<td>[SHIFT]+[4]</td>
<td>$</td>
<td>[SHIFT]+[F4]</td>
</tr>
<tr>
<td>[SHIFT]+[5]</td>
<td>%</td>
<td>[SHIFT]+[F5]</td>
</tr>
</tbody>
</table>

For Series 150i

<table>
<thead>
<tr>
<th>[MDI key]</th>
<th>Key used in the CNC screen display function</th>
<th>Alternative key of function key</th>
</tr>
</thead>
<tbody>
<tr>
<td>[CUSTOM]</td>
<td>[Ctrl]</td>
<td>[SHIFT]+[POS]</td>
</tr>
<tr>
<td>Unlabeled (or [FAPT])</td>
<td>[Alt]</td>
<td>[SHIFT]+[PROG]</td>
</tr>
<tr>
<td>[SHIFT]+[1]</td>
<td>!</td>
<td>[SHIFT]+[F1]</td>
</tr>
<tr>
<td>[SHIFT]+[2]</td>
<td>*</td>
<td>[SHIFT]+[F2]</td>
</tr>
<tr>
<td>[SHIFT]+[3]</td>
<td>^</td>
<td>[SHIFT]+[F3]</td>
</tr>
<tr>
<td>[SHIFT]+[4]</td>
<td>$</td>
<td>[SHIFT]+[F4]</td>
</tr>
<tr>
<td>[SHIFT]+[5]</td>
<td>%</td>
<td>[SHIFT]+[F5]</td>
</tr>
<tr>
<td>[SHIFT]+[6]</td>
<td>~</td>
<td>[SHIFT]+[F6]</td>
</tr>
<tr>
<td>[SHIFT]+[7]</td>
<td>‘</td>
<td>[SHIFT]+[F7]</td>
</tr>
<tr>
<td>[SHIFT]+[8]</td>
<td>&lt;</td>
<td>[SHIFT]+[F8]</td>
</tr>
<tr>
<td>[SHIFT]+[9]</td>
<td>&gt;</td>
<td>[SHIFT]+[F9]</td>
</tr>
</tbody>
</table>

NOTE
Pressing the [SHIFT] key instigates processing within
the personal computer. It is not transferred to the
CNC. Therefore, the functions performed by using the
[SHIFT] key cannot be used.

Example: [SHIFT] . . . . . . Screen copy
• Input from the PS/2 full keyboard or USB full keyboard
    Those keys not found on the MDI keyboard, with the exception
    of the alphanumeric keys, are assigned as follows:

For Series 16i/18i/21i, Series 160i/180i/210i,
Series 160is/180is/210is, Series 0i-B/C, or Power Mate i

<table>
<thead>
<tr>
<th>Full keyboard</th>
<th>Corresponding key on the MDI keyboard</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Insert]</td>
<td>[INSERT]</td>
</tr>
<tr>
<td>[Delete]</td>
<td>[DELETE]</td>
</tr>
<tr>
<td>[Home]</td>
<td>[ALTER]</td>
</tr>
<tr>
<td>[End]</td>
<td>[HELP]</td>
</tr>
<tr>
<td>[Page Up]</td>
<td>[↑PAGE]</td>
</tr>
<tr>
<td>[Page Down]</td>
<td>[↓PAGE]</td>
</tr>
<tr>
<td>[Esc]</td>
<td>[HELP]</td>
</tr>
<tr>
<td>[Tab]</td>
<td>[ALTER]</td>
</tr>
<tr>
<td>[Ctrl]+[F1] or [1] on numeric keypad</td>
<td>[POS]</td>
</tr>
<tr>
<td>[Ctrl]+[F2] or [2] on numeric keypad</td>
<td>[PROG]</td>
</tr>
<tr>
<td>[Ctrl]+[F3] or [3] on numeric keypad</td>
<td>[OFFSET/SETTING]</td>
</tr>
<tr>
<td>[Ctrl]+[F4] or [4] on numeric keypad</td>
<td>[SYSTEM]</td>
</tr>
<tr>
<td>[Ctrl]+[F5] or [5] on numeric keypad</td>
<td>[MESSAGE]</td>
</tr>
<tr>
<td>[Ctrl]+[F6] or [6] on numeric keypad</td>
<td>[GRAPH]</td>
</tr>
<tr>
<td>[Ctrl]+[F7] or [7] on numeric keypad</td>
<td>[CUSTOM]</td>
</tr>
<tr>
<td>[Ctrl]+[F8] or [8] on numeric keypad</td>
<td>Unlabeled (or [FAPT])</td>
</tr>
<tr>
<td>[F1] to [F10]</td>
<td>Relative position soft keys</td>
</tr>
<tr>
<td>[F11]</td>
<td>[FL] (leftmost soft key)</td>
</tr>
<tr>
<td>[F12]</td>
<td>[FR] (rightmost soft key)</td>
</tr>
</tbody>
</table>

For Series 30i/31i/32i, Series 300i/310i/320i, or
Series 300is/310is/320is

<table>
<thead>
<tr>
<th>Full keyboard</th>
<th>Corresponding key on the MDI keyboard</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Insert]</td>
<td>[INSERT]</td>
</tr>
<tr>
<td>[Delete]</td>
<td>[DELETE]</td>
</tr>
<tr>
<td>[Home]</td>
<td>[ALTER]</td>
</tr>
<tr>
<td>[End]</td>
<td>[HELP]</td>
</tr>
<tr>
<td>[Page Up]</td>
<td>[↑PAGE]</td>
</tr>
<tr>
<td>[Page Down]</td>
<td>[↓PAGE]</td>
</tr>
<tr>
<td>[Esc]</td>
<td>[HELP]</td>
</tr>
<tr>
<td>[Tab]</td>
<td>[ALTER]</td>
</tr>
<tr>
<td>[Ctrl]+[F1] or [1] on numeric keypad</td>
<td>[POS]</td>
</tr>
<tr>
<td>[Ctrl]+[F2] or [2] on numeric keypad</td>
<td>[PROG]</td>
</tr>
<tr>
<td>[Ctrl]+[F3] or [3] on numeric keypad</td>
<td>[OFFSET/SETTING]</td>
</tr>
<tr>
<td>[Ctrl]+[F4] or [4] on numeric keypad</td>
<td>[SYSTEM]</td>
</tr>
<tr>
<td>[Ctrl]+[F5] or [5] on numeric keypad</td>
<td>[MESSAGE]</td>
</tr>
<tr>
<td>[Ctrl]+[F6] or [6] on numeric keypad</td>
<td>[GRAPH]</td>
</tr>
<tr>
<td>[Ctrl]+[F7] or [7] on numeric keypad</td>
<td>[CUSTOM1]</td>
</tr>
<tr>
<td>[Ctrl]+[F8] or [8] on numeric keypad</td>
<td>[CUSTOM2]</td>
</tr>
<tr>
<td>[F1] to [F10]</td>
<td>Relative position soft keys</td>
</tr>
<tr>
<td>[F11]</td>
<td>[FL] (leftmost soft key)</td>
</tr>
<tr>
<td>[F12]</td>
<td>[FR] (rightmost soft key)</td>
</tr>
</tbody>
</table>
For Series 15\textit{i} or Series 150\textit{i}

<table>
<thead>
<tr>
<th>Full keyboard</th>
<th>Corresponding key on the MDI keyboard</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Insert]</td>
<td>[INSERT]</td>
</tr>
<tr>
<td>[Delete]</td>
<td>[DELETE]</td>
</tr>
<tr>
<td>[Home]</td>
<td>[ALTER]</td>
</tr>
<tr>
<td>[End]</td>
<td>[HELP]</td>
</tr>
<tr>
<td>[Page Up]</td>
<td>[ \textup{↑} PAGE]</td>
</tr>
<tr>
<td>[Page Down]</td>
<td>[ \textup{↓} PAGE]</td>
</tr>
<tr>
<td>[Esc]</td>
<td>[HELP]</td>
</tr>
<tr>
<td>[Tab]</td>
<td>[ALTER]</td>
</tr>
<tr>
<td>[Ctrl]+[F1] or [1] on numeric keypad</td>
<td>[POS]</td>
</tr>
<tr>
<td>[Ctrl]+[F2] or [2] on numeric keypad</td>
<td>[PROG]</td>
</tr>
<tr>
<td>[Ctrl]+[F3] or [3] on numeric keypad</td>
<td>[OFFSET/SETTING]</td>
</tr>
<tr>
<td>[Ctrl]+[F4] or [4] on numeric keypad</td>
<td>[SYSTEM]</td>
</tr>
<tr>
<td>[Ctrl]+[F5] or [5] on numeric keypad</td>
<td>[MESSAGE]</td>
</tr>
<tr>
<td>[Ctrl]+[F6] or [6] on numeric keypad</td>
<td>[GRAPH]</td>
</tr>
<tr>
<td>[Ctrl]+[F7] or [7] on numeric keypad</td>
<td>[CUSTOM]</td>
</tr>
<tr>
<td>[Ctrl]+[F8] or [8] on numeric keypad</td>
<td>Unlabeled (or [FAPT])</td>
</tr>
<tr>
<td>[F1] to [F10]</td>
<td>Relative position soft keys</td>
</tr>
<tr>
<td>[F11]</td>
<td>[FL] (leftmost soft key)</td>
</tr>
<tr>
<td>[F12]</td>
<td>[FR] (rightmost soft key)</td>
</tr>
</tbody>
</table>

For Series 150-B

<table>
<thead>
<tr>
<th>Full keyboard</th>
<th>Corresponding key on the MDI keyboard</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Insert]</td>
<td>[INPUT]</td>
</tr>
<tr>
<td>[Delete]</td>
<td>[DELETE]</td>
</tr>
<tr>
<td>[Home]</td>
<td>[ALTER]</td>
</tr>
<tr>
<td>[End]</td>
<td>[HELP]</td>
</tr>
<tr>
<td>[Page Up]</td>
<td>[ \textup{↑} PAGE]</td>
</tr>
<tr>
<td>[Page Down]</td>
<td>[ \textup{↓} PAGE]</td>
</tr>
<tr>
<td>[Ctrl]+[F1] or [1] on numeric keypad</td>
<td>[POS]</td>
</tr>
<tr>
<td>[Ctrl]+[F2] or [2] on numeric keypad</td>
<td>[PROG]</td>
</tr>
<tr>
<td>[Ctrl]+[F3] or [3] on numeric keypad</td>
<td>[OFFSET]</td>
</tr>
<tr>
<td>[Ctrl]+[F4] or [4] on numeric keypad</td>
<td>[SYSTEM]</td>
</tr>
<tr>
<td>[Ctrl]+[F5] or [5] on numeric keypad</td>
<td>[MESSAGE]</td>
</tr>
<tr>
<td>[Ctrl]+[F6] or [6] on numeric keypad</td>
<td>[SERVICE]</td>
</tr>
<tr>
<td>[Ctrl]+[F7] or [7] on numeric keypad</td>
<td>[MESSAGE]</td>
</tr>
<tr>
<td>[Ctrl]+[F8] or [8] on numeric keypad</td>
<td>[SERVICE]</td>
</tr>
<tr>
<td>[Ctrl]+[F9] or [9] on numeric keypad</td>
<td>[CNC/PMC]</td>
</tr>
<tr>
<td>[Ctrl]+[F10] or [0] on numeric keypad</td>
<td>[FAPT]</td>
</tr>
<tr>
<td>[Ctrl]+[F11]</td>
<td>[AUX]</td>
</tr>
<tr>
<td>[F1] to [F10]</td>
<td>Relative position soft keys</td>
</tr>
<tr>
<td>[F11]</td>
<td>[FL] (leftmost soft key)</td>
</tr>
</tbody>
</table>

**NOTE**

1. The [RESET] MDI key is not assigned to the full keyboard to prevent possible problems. When using the [RESET] key, use that on the MDI keyboard. (The [RESET] MDI key is effective even when the CNC screen display function is being executed.)

2. The key assignment of the full keyboard can be changed. For an explanation of how to change the key assignment, see Section 3.6.
2.6 INPUT WITH THE MOUSE AND TOUCH PANEL

This section explains input with the mouse and touch panel.

**Operation 1**
Click a soft key by using the mouse.

For Series 16i/18i/21i and Series 160i/180i/210i

![Image of a CNC screen with soft keys labeled ABS, REL, ALL, and a time display 22:51:42]

**Operation 2**
Physically press a soft key on the touch panel.

**NOTE**
Within a CNC screen, the mouse and touch panel can be used only for soft key operations.
2.7 FUNCTION KEYS

This section explains how to select function keys by using the full keyboard and mouse.

- When the full keyboard is used
  The function keys on the MDI keyboard are assigned to the full keyboard as follows:

For Series 16i/18i/21i, Series 160i/180i/210i, Series 160is/180is/210is, Series 0i-B/C, Series 15i, Series 150i, or Power Mate i

<table>
<thead>
<tr>
<th>Full keyboard</th>
<th>Function key on the MDI keyboard</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>[POS]</td>
<td>[1] on numeric keypad or [Ctrl]+[F1]</td>
<td></td>
</tr>
<tr>
<td>[PROG]</td>
<td>[2] on numeric keypad or [Ctrl]+[F2]</td>
<td></td>
</tr>
<tr>
<td>[OFFSET/SETTING]</td>
<td>[3] on numeric keypad or [Ctrl]+[F3]</td>
<td></td>
</tr>
<tr>
<td>[SYSTEM]</td>
<td>[4] on numeric keypad or [Ctrl]+[F4]</td>
<td></td>
</tr>
<tr>
<td>[MESSAGE]</td>
<td>[5] on numeric keypad or [Ctrl]+[F5]</td>
<td></td>
</tr>
<tr>
<td>[GRAPH]</td>
<td>[6] on numeric keypad or [Ctrl]+[F6]</td>
<td></td>
</tr>
<tr>
<td>[CUSTOM]</td>
<td>[7] on numeric keypad or [Ctrl]+[F7]</td>
<td></td>
</tr>
<tr>
<td>Unlabeled (or [FAPT])</td>
<td>[8] on numeric keypad or [Ctrl]+[F8]</td>
<td></td>
</tr>
</tbody>
</table>

For Series 30i/31i/32i, Series 300i/310i/320i, or Series 300is/310is/320is

<table>
<thead>
<tr>
<th>Full keyboard</th>
<th>Function key on the MDI keyboard</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>[POS]</td>
<td>[1] on numeric keypad or [Ctrl]+[F1]</td>
<td></td>
</tr>
<tr>
<td>[PROG]</td>
<td>[2] on numeric keypad or [Ctrl]+[F2]</td>
<td></td>
</tr>
<tr>
<td>[OFFSET/SETTING]</td>
<td>[3] on numeric keypad or [Ctrl]+[F3]</td>
<td></td>
</tr>
<tr>
<td>[SYSTEM]</td>
<td>[4] on numeric keypad or [Ctrl]+[F4]</td>
<td></td>
</tr>
<tr>
<td>[MESSAGE]</td>
<td>[5] on numeric keypad or [Ctrl]+[F5]</td>
<td></td>
</tr>
<tr>
<td>[GRAPH]</td>
<td>[6] on numeric keypad or [Ctrl]+[F6]</td>
<td></td>
</tr>
<tr>
<td>[CUSTOM1]</td>
<td>[7] on numeric keypad or [Ctrl]+[F7]</td>
<td></td>
</tr>
<tr>
<td>[CUSTOM2]</td>
<td>[8] on numeric keypad or [Ctrl]+[F8]</td>
<td></td>
</tr>
</tbody>
</table>

For Series 150-B

<table>
<thead>
<tr>
<th>Full keyboard</th>
<th>Function key on the MDI keyboard</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>[POS]</td>
<td>[1] on numeric keypad or [Ctrl]+[F1]</td>
<td></td>
</tr>
<tr>
<td>[PROG]</td>
<td>[2] on numeric keypad or [Ctrl]+[F2]</td>
<td></td>
</tr>
<tr>
<td>[OFFSET]</td>
<td>[3] on numeric keypad or [Ctrl]+[F3]</td>
<td></td>
</tr>
<tr>
<td>[P-CHECK]</td>
<td>[4] on numeric keypad or [Ctrl]+[F4]</td>
<td></td>
</tr>
<tr>
<td>[SETTING]</td>
<td>[5] on numeric keypad or [Ctrl]+[F5]</td>
<td></td>
</tr>
<tr>
<td>[SERVICE]</td>
<td>[6] on numeric keypad or [Ctrl]+[F6]</td>
<td></td>
</tr>
<tr>
<td>[MESSAGE]</td>
<td>[7] on numeric keypad or [Ctrl]+[F7]</td>
<td></td>
</tr>
<tr>
<td>[OTHERS]</td>
<td>[8] on numeric keypad or [Ctrl]+[F8]</td>
<td></td>
</tr>
</tbody>
</table>
2. OPERATION

- When the mouse is used
  1. Choose the [Function key] from the submenu of [View] on
     the menu bar.

When a CNC in the is series is used, choose a menu item by
performing the following key operation.

1. Press the keys below to display the [View] menu.
   For Series 160is/180is/210is : [Unlabeled key] + [V]
   For Series 300is/310is/320is : [ALT] + [V]


2. The function switch screen appears. Choose the button of a
desired screen.

   Series 16i/18i/21i, Series 160i/180i/210i,
   Series 160is/180is/210is, Series 0i-B/C, Series 15i,
   Series 30i/31i/32i, Series 300i/310i/320i,
   Series 150i, Power Mate i, Series 300is/310is/320is

<table>
<thead>
<tr>
<th>Button</th>
<th>Key on MDI keyboard</th>
<th>Button</th>
<th>Key on MDI keyboard</th>
</tr>
</thead>
<tbody>
<tr>
<td>POS</td>
<td>[POS]</td>
<td>POS</td>
<td>[POS]</td>
</tr>
<tr>
<td>PROG</td>
<td>[PROG]</td>
<td>PROG</td>
<td>[PROG]</td>
</tr>
<tr>
<td>OFST</td>
<td>[OFFSET/SETTING]</td>
<td>OFST</td>
<td>[OFFSET/SETTING]</td>
</tr>
<tr>
<td>CSTM</td>
<td>[CUSTOM]</td>
<td>CST1</td>
<td>[CUSTOM1]</td>
</tr>
<tr>
<td>SYS</td>
<td>[SYSTEM]</td>
<td>SYS</td>
<td>[SYSTEM]</td>
</tr>
<tr>
<td>MSG</td>
<td>[MESSAGE]</td>
<td>MSG</td>
<td>[MESSAGE]</td>
</tr>
<tr>
<td>GRAP</td>
<td>[GRAPH]</td>
<td>GRAP</td>
<td>[GRAPH]</td>
</tr>
<tr>
<td>FAPT</td>
<td>[FAPT]</td>
<td>CST2</td>
<td>[CUSTOM2]</td>
</tr>
</tbody>
</table>
NOTE
The button appears when conversational automatic programming function II for lathe is provided.

Series 150-B

<table>
<thead>
<tr>
<th>Button</th>
<th>Key on MDI keyboard</th>
</tr>
</thead>
<tbody>
<tr>
<td>POS</td>
<td>[POS]</td>
</tr>
<tr>
<td>PROG</td>
<td>[PROG]</td>
</tr>
<tr>
<td>OFST</td>
<td>[OFFSET]</td>
</tr>
<tr>
<td>PCHK</td>
<td>[P-CHECK]</td>
</tr>
<tr>
<td>SET</td>
<td>[SETTING]</td>
</tr>
<tr>
<td>SERY</td>
<td>[SERVICE]</td>
</tr>
<tr>
<td>MSG</td>
<td>[MESSAGE]</td>
</tr>
<tr>
<td>OTHER</td>
<td>[OTHRES]</td>
</tr>
</tbody>
</table>

NOTE
The function switch screen appears at the center of the screen for the first time. Move the screen to any desired location. When the screen is displayed for the second and subsequent times, the screen appears at the location to which the screen was moved previously.
2.8 DATA INPUT/OUTPUT

This section explains data input/output operations (input to and output from the memory card and hard disk).

**NOTE**
This function cannot be used with CNCs in the Series 150-B.

When you use a CNC in the Series 160i/180i/210i with the personal computer function, or an LCD-mounted-type CNC in the Series 160is/180is/210is or Series 300is/310is/320is, a memory card in the PCMCIA slot at the front is connected to Windows side, rather than the CNC side. The memory card is thus handled as a kind of drive or folder (removable disk) connected to Windows.

To use a memory card for input/output, set up the following parameters.

| CNC parameter No. 20 | 4 |

When you use a personal computer connected using a high-speed serial bus or Ethernet board to the CNC or you use the display of a CNC in the is series, a memory card is connected to the CNC side. In this case, input/output operations for the memory card are applied to the CNC, rather than Windows.

However, a folder on the Windows side can be specified as the data input/output destination by setting the following parameter:

For Series 16i/18i/21i, Series 160i/180i/210i,
Series 160is/180is/210is, Series 30i/31i/32i,
Series 300i/310i/320i, Series 300is/310is/320is, Series 0i-B/C, or Power Mate i :

- Set CNC parameter No. 20 to 4.
- Set parameter No. 0300 bit 0 to 1.

For Series 15i or Series 150i :

- Set CNC parameters No. 20 to No. 23 to 0 or 8.
- Set parameter No. 7713 bit 2 to 1.

This can change all input/output operations for the memory card connected to the CNC to input/output operations for the folder on the Windows side.

- Assignment to a memory card drive/folder
  - The actual drive and folder to which the memory card is assigned depends on the configuration on the Windows side. Set the drive and folder to which the memory card has been assigned, as described below.
  - The following explanation uses an example where the memory card has been assigned to the root folder of the D drive.
For a CNC in the is series, you must set the Storage Card2 folder to input to and output from a memory card in the PCMCIA slot at the front.

1. Choose [Data input/output...] from the submenu of [File] in the menu bar.

When a CNC in the is series is used, choose a menu item by performing the following key operation.
(1) Press the keys below to display the [File] menu.
   For Series 160is/180is/210is : [Unlabeled key] + [F]
   For Series 300is/310is/320is : [ALT] + [F]
(2) Select [Data input/output...] in the [File] menu.

2. The [Data Input/Output] dialog box appears.

3. Enter the memory card drive (D:\), then click the <OK> button.

When the <Browse> button is pressed on the above screen, the [Browse for Folder] dialog box appears. Choose an appropriate folder, then click the <OK> button. Then, a folder name can be entered.
After the above steps have been completed, every memory card I/O operation by the CNC is performed for the memory card (D:\) on the Windows.

- Assignment to a hard disk
  The I/O destination can be assigned to a hard disk as well as the memory card drive. Assignment to a hard disk is performed in the same way as for a memory card drive. A drive may be specified directly, or a subfolder may be specified. Once the assignment is completed, the CNC data is input to or output from the folder.
  Any of the folders in the Windows file system, including the memory card, hard disk, floppy disk, and drives connected through a network, can be assigned.
  The contents of an assigned I/O folder can be checked on the CNC screen.
For a CNC in the is series, a Compact Flash card is mounted instead of a hard disk. Therefore, set the data input/output destination as shown below.
\Storage Card\...\... (...: folder name)

<table>
<thead>
<tr>
<th>NO.</th>
<th>FILE NAME</th>
<th>SIZE</th>
<th>DATE</th>
</tr>
</thead>
<tbody>
<tr>
<td>0001</td>
<td>.</td>
<td>0</td>
<td>04-06-09</td>
</tr>
<tr>
<td>0002</td>
<td>.</td>
<td>0</td>
<td>04-06-09</td>
</tr>
<tr>
<td>0003</td>
<td>FOLDER</td>
<td></td>
<td>04-06-09</td>
</tr>
<tr>
<td>0004</td>
<td>00010.TXT</td>
<td>1939</td>
<td>04-06-09</td>
</tr>
</tbody>
</table>

Shown above is a sample screen displayed when the following folder (C:\NCDATA) is assigned. The O numbers below [PROGRAM] indicate the program names contained in memory in the CNC.

<table>
<thead>
<tr>
<th>Hard disk in the Windows</th>
<th>CNC internal memory</th>
</tr>
</thead>
<tbody>
<tr>
<td>C:\NCDATA \00010.TXT (file)</td>
<td>00001</td>
</tr>
<tr>
<td>\FOLDER (folder)</td>
<td>00020</td>
</tr>
</tbody>
</table>

**NOTE**

1. When a subfolder is specified as an I/O folder, "." or "." is indicated. FOLDER indicates a folder name. Any I/O operation for these folders results in an error.

2. Only uppercase alphanumeric characters can be displayed on the CNC screen. Any lowercase characters included in folder names on the Windows are converted to uppercase when displayed. Kana and kanji characters are not displayed correctly.
2.9 CLEARING ALARMS

This section explains how to clear CNC alarms that may appear at power-on.

**NOTE**
This function cannot be used with CNCs in the is series, Series 15i, Series 150i, or Series 150-B.

For the CNC screen display function, multiple keys cannot be pressed at the same time. Use menus to clear CNC alarms as described below.

For Series 16i/18i/21i, Series 160i/180i/210i, Series 0i-B, or Power Mate i

<table>
<thead>
<tr>
<th>Alarm number</th>
<th>Key on the MDI keyboard for clear operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>PS000</td>
<td>[RESET]+[CAN]</td>
</tr>
<tr>
<td>PS101</td>
<td>[RESET]+[PROG]</td>
</tr>
</tbody>
</table>

For Series 30i/31i/32i or Series 300i/310i/320i

<table>
<thead>
<tr>
<th>Alarm number</th>
<th>Key on the MDI keyboard for clear operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>SW000</td>
<td>[RESET]+[CAN]</td>
</tr>
</tbody>
</table>

To clear CNC alarms, perform the following:

Operation 1
Clearing from a pop-up menu
Click the right mouse button on the screen of the CNC screen display function.
A pop-up menu as shown below appears. Choose [Alarm clear] and then select the desired alarm in the submenu of [Alarm clear].

![Pop-up menu](image)

Operation 2
Clearing from the menu bar
Choose [Alarm clear] in the submenu of [Option] on the menu bar and then select the desired alarm in the submenu of [Alarm clear].

![Menu bar](image)
2.10 Copying Screens (is Series)

This section explains how to produce file output of CNC screen images displayed by the CNC screen display function for CNCs in the Series 160is/180is/210is or Series 300is/310is/320is, as bitmap data (BMP file).

**NOTE**
This function can only be used with CNCs in the is series. For other models, use the Windows standard screen copy function with the PrintScreen key.

**Operation procedure**

1. Press the keys below to display the [File] menu.
   For Series 160is/180is/210is: [Unlabeled key] + [F]
   For Series 300is/310is/320is: [ALT] + [F]


3. Copying completes when the hourglass disappears.

**Notes**

- The output destination of bitmap data is the same as the data input/output destination described in Section 2.8.
- A bitmap file is named HDCPY001.BMP. When two or more bitmap files are output, they are named as shown below.
  HDCPY001.BMP, HDCPY002.BMP, HDCPY003.BMP, …
  Bitmap files are automatically serial-numbered after HDCPY in an incremental manner until the CNC screen display function is terminated. When the CNC screen display function is restarted, bitmap files are serial-numbered, starting at HDCPY001.BMP again. The previous bitmap files are overwritten.
- A screen image is output as 256-color bitmap data. A bitmap file has a size of approximately 300 KB and is output in approximately 4 seconds.
- Bitmap data does not contain pull-down menus and the hourglass.
- Blinking characters and cursor cannot be output properly.
2.11 DISPLAYING VERSION INFORMATION

This section explains how to display information used for maintenance such as version information of the CNC screen display function.

Operation procedure


![CNC Screen Display Function]

When a CNC in the is series is used, choose a menu item by performing the following key operation.

(1) Press the keys below to display the [Help] menu.
   For Series 160is/180is/210is: [Unlabeled key] + [H]
   For Series 300is/310is/320is: [ALT] + [H]

(2) Select [About] in the [Help] menu.

2. The About CNC Screen Display Function appears.

![About CNC Screen Display Function]

The displayed information includes:
- Information about the version of the CNC screen display function
- CNC type
- CNC software series
- CNC software version
This chapter explains the settings for the CNC screen display function.
3.1 SWITCHING BETWEEN LOCATIONS TO SAVE THE SETTINGS

This section explains how to switch between locations to save the settings.

**NOTE**

This function cannot be used with CNCs in the i series.

You can choose whether to save the settings for the CNC screen display function, including display languages and display languages, in different locations for different connections, or to save the settings in a common location. To change the location to save the settings, perform the following:


2. The setting screen appears. In the selection list on the screen, select a listed connection destination (e.g., Node1) to save the settings in different locations for different connections, or select <Common> to save the settings in a common location. Then, click the <OK> button.
3.2 SWITCHING BETWEEN DISPLAY LANGUAGES

This section explains how to switch from one display language to another.

To switch between display languages, use the following procedure (where, an example for switching from English to Japanese is given):

1. Choose [Setting...] from the submenu of [Option] on the menu bar.

![Menu Bar with Setting Option]

When a CNC in the is series is used, choose a menu item by performing the following key operation.
(1) Press the keys below to display the [Option] menu.
   For Series 160is/180is/210is: [Unlabeled key] + [O]
   For Series 300is/310is/320is: [ALT] + [O]
(2) Select [Setting] in the [Option] menu.

2. The Setting screen appears. Choose [Language]. Choose the language you want to use, then choose the <OK> button.

![Setting Screen with Language Option]

3. The following message appears. Choose the <OK> button, then restart the CNC screen display function.

![Message to Restart Screen Display]
## NOTE

1. Switching display languages in the CNC screen display function changes only the language of the displayed items specific to the CNC screen display function, such as the title bar, menu bar, and pop-up menus. The CNC screen display part is displayed in the specified CNC display language.

2. When a language with a font not supported by Windows is selected, the language cannot be displayed correctly. Set a display language supported by Windows.
3.3 SETTING SCREEN RESOLUTIONS

This section explains how to set a screen resolution for the 10.4-inch view.

Only for the 10.4-inch view, you can change the standard resolution of 640 × 480 dots (VGA) to 800 × 600 dots (SVGA) or 1,024 × 768 dots (XGA) to obtain an enlarged view.

NOTE
The enlarged view capability is not enabled in all models. There is a limitation on the types of screens for which enlarged views can be obtained. See Section 2.4, “Types of Displayed Screens,” for an explanation of the specifications and limitations for the enlarged view.

To change the screen resolution, perform the following:


   When a CNC in the is series is used, choose a menu item by performing the following key operation.
   (1) Press the keys below to display the [Option] menu.
       For Series 160is/180is/210is: [Unlabeled key] + [O]
       For Series 300is/310is/320is: [ALT] + [O]
   (2) Select [Setting] in the [Option] menu.

2. The setting screen appears. Select [Screen]. Select the desired resolution and click the <OK> button.
3. The following message appears. Click the <OK> button, and then restart the CNC screen display function.
3.4 Setting the Display Timing at Startup

This section explains how to change the timing at which the CNC screen display function is displayed in the foreground at startup.

**NOTE**

This function cannot be used with CNCs in the is series.

When you start the CNC screen display function and a user application virtually simultaneously, which application is operational as a foreground window is unpredictable. You can set timing at which the CNC screen display function is always displayed in the foreground, without having to making changes to the user application.

To change the timing setting, perform the following:


2. The setting screen appears. Select [Startup].

To display the CNC screen display function as a foreground window after startup, select <Foreground>. In <Delay time>, enter a time interval, in milliseconds, from when the function is started and to when it is displayed as a foreground window.

**NOTE**

When you select <Foreground>, enter a number of 1 or greater in <Delay time>. If the delay time is 0, the setting for displaying the function in foreground becomes disabled.

After entering a value, click the <OK> button.
3.5 SETTING ANIMATED SIMULATION FOR TURNING

This section explains how to set the data for animated simulation for turning.

The setting screen is displayed for the Series 16i/18i/21i-T, Series 160i/180i/210i-T, and Series 160is/180is/210is-T (including the two-path control function).

**NOTE**

This setting will be enabled in the future when the CNC screen display function supports the Super CAP T/Super CAPi T, CAPI, and CAPII/Symbol CAPi T.

To modify the data for animated simulation for turning, use the procedure explained below.

1. Choose [Setting...] from the submenu of [Option] on the menu bar.

2. The Setting screen appears. Select [Lathe animation]. Set the display speed of animated simulation for turning, then choose the <OK> button.

**NOTE**

The display speed of animated simulation for turning is indicated as a number of dots. The display is refreshed each time the tool moves the specified number of dots. The lower the speed, the smoother the animation appears.
3.6 CHANGING KEYBOARD ASSIGNMENT

This section explains the assignment of the MDI keys to the full keyboard.

Changes in keyboard assignment are reflected to the key definition file (keymat file) in the directory where the CNC screen display function has been installed. This file is installed as read-only. Before modifying its contents, change the file attribute.

- Changing an assignment

To change the standard assignment, use the procedure explained below. In the explanation, an example for changing from [Ctrl]+[Num-9] to [PROG] is used.


When a CNC in the is series is used, choose a menu item by performing the following key operation.

(1) Press the keys below to display the [Option] menu.
   - For Series 160is/180is/210is: [Unlabeled key] + [O]
   - For Series 300is/310is/320is: [ALT] + [O]

(2) Select [Keyboard] in the [Option] menu.

2. A list of the current assignments is displayed on the Keyboard Setup screen, as follows:
3. Choose a desired key (Num-9) of the full keyboard from the list or the list in the combo box.

4. When the selected key is to be pressed together with the [Ctrl] key, check the attribute item.

5. Select the corresponding MDI key (PROG) from the combo box.

6. Click the button.
• Deleting an assignment
To delete an assignment, use the procedure explained below. In the explanation, an example of deleting the [Delete] key is used. As the result of this deletion example, the full keyboard has no key that functions as the [DELETE] MDI key.


2. A list of the current assignments is displayed on the Keyboard setup screen, as follows:

3. Choose the full-keyboard key (Delete) you want to delete from the list.

4. Click the button.
3. SETTING

- Notes on changing the keyboard assignment

⚠️ CAUTION
When both the full keyboard and MDI keyboard are to be used, do not change the assignment. If the setting of a key common to an MDI key is changed, the MDI key assignment is also changed at the same time.

NOTE
The result of editing (modification and deletion) is reflected by clicking the <OK> button. Clicking the <Cancel> button cancels the edit result, restoring the status existing before the editing.
APPENDIX
ALARMS

The alarms generated by the CNC screen display function are explained below.

**CNC link failed.**

<table>
<thead>
<tr>
<th>Explanation</th>
<th>Action</th>
</tr>
</thead>
</table>
| There is no response from the CNC. | (1) Check whether the power to the CNC is turned on.  
(2) When the personal computer or display unit is connected using a high-speed serial bus, check whether the cables are connected correctly.  
(3) Check whether driver installation, setting, and other operations performed before the installation of the CNC screen display function are correct.  
(4) For a personal computer connected to the CNC via the Ethernet, check its network setting and connection. |

**Function is already in use with another PC.**

<table>
<thead>
<tr>
<th>Explanation</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>The CNC screen display function has already been executed from another personal computer or display unit.</td>
<td>Only one instance of the CNC screen display function can be started for each CNC at one time. After the CNC screen display function has been terminated on another personal computer or display unit, try starting the function again.</td>
</tr>
</tbody>
</table>

**Restart this application to restore this setting.**

<table>
<thead>
<tr>
<th>Explanation</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>This alarm is generated when switching between display languages has been performed.</td>
<td>Restart the CNC screen display function.</td>
</tr>
</tbody>
</table>

**Font pattern file (%s) open failed.**

<table>
<thead>
<tr>
<th>Explanation</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>The font pattern file indicated by %s does not exist.</td>
<td>The font pattern file must be placed in the same folder as the executable file of the CNC screen display function (CNCScrn.exe). Copy the font file to the folder containing the executable file. If the font file does not exist, re-install the CNC screen display function.</td>
</tr>
</tbody>
</table>

**Font pattern file (%s) is invalid.**

<table>
<thead>
<tr>
<th>Explanation</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>The font pattern file indicated by %s is destroyed.</td>
<td>Re-install the CNC screen display function.</td>
</tr>
</tbody>
</table>
### Keyboard allocation file (Keymatrx.dat) open failed.

<table>
<thead>
<tr>
<th>Explanation</th>
<th>The keyboard assignment file does not exist.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action</td>
<td>The keyboard assignment file must be placed in the same folder as the executable file of the CNC screen display function (CNCScrn.exe or CNCScrnE.exe). Copy the keyboard assignment file to the folder containing the executable file. If the keyboard assignment file does not exist, re-install the CNC screen display function.</td>
</tr>
</tbody>
</table>

### Keyboard assignment file (%s) is write-protected.

<table>
<thead>
<tr>
<th>Explanation</th>
<th>The save setup results cannot be saved as the file attributes for the keyboard assignment file to be displayed by %s are read-only.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action</td>
<td>Change the file attributes, and cancel read-only.</td>
</tr>
</tbody>
</table>

### Function key assignment file (%s) open failed:

<table>
<thead>
<tr>
<th>Explanation</th>
<th>The function key assignment file does not exist.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action</td>
<td>The function key assignment file to be displayed by %s must be in the same folder as the execution file (CNCScrn.exe) of the CNC screen display function. Copy the function key assignment file to the same folder as the execution file. When there is no function key assignment file, re-install the CNC screen display function.</td>
</tr>
</tbody>
</table>

### Key definition assignment file (%s) open failed:

<table>
<thead>
<tr>
<th>Explanation</th>
<th>The key definition file does not exist.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action</td>
<td>The key definition file to be displayed by %s must be in the same folder as the execution file (CNCScrn.exe) of the CNC screen display function. Copy the key definition file to the same folder as the execution file. When there is no function key assignment file, re-install the CNC screen display function.</td>
</tr>
</tbody>
</table>

### Please select folder.

<table>
<thead>
<tr>
<th>Explanation</th>
<th>No folder is selected in data I/O setting.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action</td>
<td>Set a correct folder.</td>
</tr>
</tbody>
</table>

### Folder is not chosen.

<table>
<thead>
<tr>
<th>Explanation</th>
<th>No folder is set in data I/O setting.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action</td>
<td>Set a correct folder.</td>
</tr>
</tbody>
</table>

### The folder does not exist or invalid folder name.

<table>
<thead>
<tr>
<th>Explanation</th>
<th>A nonexistent folder or an invalid folder name was set in data I/O setting.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action</td>
<td>Set a correct folder.</td>
</tr>
</tbody>
</table>

### CNC Option is not found ! Option Name: Extension Driver/Library Function.

<table>
<thead>
<tr>
<th>Explanation</th>
<th>The CNC extension driver/library function option is not found.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action</td>
<td>Purchase the option.</td>
</tr>
</tbody>
</table>
CNC Option is not found! Option Name: CNC Screen Display Function.

<table>
<thead>
<tr>
<th>Explanation</th>
<th>The CNC screen display function option for the CNC is not found.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action</td>
<td>Purchase the option.</td>
</tr>
</tbody>
</table>

CNC type differs from HSSB device set value.

<table>
<thead>
<tr>
<th>Explanation</th>
<th>The CNC Type of the HSSB device set value differs from the connected CNC.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action</td>
<td>Change the CNC Type of the HSSB device set value to the same Type as the connected CNC.</td>
</tr>
</tbody>
</table>

CNC not supported by CNC screen display function is connected.

<table>
<thead>
<tr>
<th>Explanation</th>
<th>A CNC not supported by the CNC screen display function is connected.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action</td>
<td>Change the CNC, or consider discontinued use of the CNC screen display function.</td>
</tr>
</tbody>
</table>

Enter host name or IP address.

<table>
<thead>
<tr>
<th>Explanation</th>
<th>Neither a host name nor IP address is specified in the destination specification dialog box of the Ethernet version.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action</td>
<td>Specify the correct host name or IP address.</td>
</tr>
</tbody>
</table>

Enter port number.

<table>
<thead>
<tr>
<th>Explanation</th>
<th>No target CNC port number is specified in the destination specification dialog box of the Ethernet version.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action</td>
<td>Specify the correct port number.</td>
</tr>
</tbody>
</table>

Enter a timeout value.

<table>
<thead>
<tr>
<th>Explanation</th>
<th>No communication timeout value is specified in the destination specification dialog box of the Ethernet version.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action</td>
<td>Specify a timeout value (in seconds).</td>
</tr>
</tbody>
</table>

%s is not found.

<table>
<thead>
<tr>
<th>Explanation</th>
<th>An attempt to connect to a CNC having a host name or IP address indicated with %s failed.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action</td>
<td>(1) Check that the CNC is supplied with power. (2) Check the setting of the FANUC Ethernet board. (3) Check the TCP/IP setting in the personal computer. (4) Check the network connection. (5) If the CNC to be connected has been specified using a host name, check the setting of the HOSTS file and DNS server. Alternatively, try to connect using an IP address.</td>
</tr>
</tbody>
</table>

The signal setting is invalid.

<table>
<thead>
<tr>
<th>Explanation</th>
<th>No close signal is set in the Close Signal dialog box of the Ethernet version.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action</td>
<td>Specify the correct close signal.</td>
</tr>
</tbody>
</table>
B. ETHERNET VERSION COMMUNICATION LOG FUNCTION

This appendix describes the communication log function, which is unique to the Ethernet version of the CNC screen display function.

If an error occurs within the CNC screen display function, the communication log function is used to save the information about the cause of the error to a file for early problem solving.

The output of the CNC screen display function can be specified using four different levels.

**Level 0**
No log is output.

**Level 1 (default)**
Information about TCP/IP start/stop events and all errors that occurred is output.

**Level 2**
In addition to the information output at level 1, information about all events related to TCP/IP is output.

**Level 3**
In addition to the information output at level 2, all communicated data is output.

Communication log data is saved as a file named NsSrnEth.log in the Fwlib folder within the Windows directory.

**Displaying the communication log**
The current communication log can be viewed using the "FWLOG.EXE" utility. The FWLOG.EXE utility is included in the following software.

- System CD-ROM (version 2.0 or later)
  FANUC Open CNC Drivers and Libraries (FOCAS2)
  (A02B-0207-K737)

- System floppy disks (version 1.9 or earlier)
  FANUC Open CNC FOCAS1/Ethernet Libraries
  (A02B-0207-K732#ZZ07)

Start FWLOG.EXE directly from the CD-ROM or floppy disk. Alternatively, copy this file to any folder on the hard disk and start it. When the FWLOG.EXE utility starts, the Open dialog box appears. Use the arrow keys to select NCSRNETH.LOG and click the [OK] button. The log data screen appears.
The following explains how to work with the log display screen.

- **Moving the cursor**
  Press any of the arrow keys on the keyboard.
  You can page up or down by using any of the following methods.
  - Choose [View] on the menu bar and then [Previous Page] or [Next Page].
  - Press the [Page Up] or [Page Down] key on the keyboard.

- **Copying to the clipboard**
  You can copy strings in the display area to the clipboard by using the following method.
  1. While holding down the [Shift] key on the keyboard, press any of the arrow keys to highlight the log record you want to copy.
  2. Choose [Edit] on the menu bar and then [Copy], or press the [Ctrl]+[C] keys on the keyboard.

- **Jumping to a specified line**
  Display the Jump dialog box by using any of the following methods.
  - Choose [Edit] on the menu bar and then [Jump].
  - Press the [Ctrl]+[J] keys on the keyboard.
  Enter the number of a record you want to display, and then click the [OK] button.

- **Making a search**
  Display the Find dialog box by using any of the following methods.
  - Choose [Edit] on the menu bar and then [Find].
  - Press the [Ctrl]+[F] keys on the keyboard.
  Enter a keyword you want to find, and then click the [OK] button.

- **Printing**
  Display the Print dialog box by using any of the following methods.
  - Choose [File] on the menu bar and then [Print].
  - Press the [Ctrl]+[P] keys on the keyboard.
  Select a range to print, and then click the [OK] button.

<table>
<thead>
<tr>
<th>Range</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>Prints the entire log file.</td>
</tr>
<tr>
<td>This Page</td>
<td>Prints only a page currently displayed on the screen.</td>
</tr>
</tbody>
</table>

- **Clearing a log**
  Choose [View] on the menu bar and then [Clear] to display the log clear dialog.
  Click the [OK] button.
Monitor mode
In monitor mode, a log file is read at a specified interval (2 seconds by default) and the screen is refreshed. Monitor mode is off by default. When monitor mode is on, the following functions are disabled.
- Print
- Copy
- Search
- Jump
- Previous page/next page
- Log clear
Monitor mode is switched between on and off by choosing [View] on the menu bar and then [Monitor].

Page setting
You can change the number of log records per page and the refresh interval for monitor mode by using the following method.
1. Chose [View] on the menu bar and then [Page Setting...] to display the Page dialog box.
2. Change the number of log records and the refresh interval for monitor mode.
3. Click the [OK] button.

Controlling logging
You can check the current log level by using the LOGLEVEL.EXE utility. (Start LOGLEVEL.EXE directly from the CD-ROM or floppy disk. Alternatively, copy this file to any folder on the hard disk and start it.)

(Example)
```
C:\>LOGLEVEL
Current log level = 1 (Standard)
```
You can change the log level by specifying a level with an argument of the LOGLEVEL.EXE utility. To cause the new log level to take effect, you must restart the CNC screen display function.

(Example)
```
C:\>LOGLEVEL 3
New log level = 3 (Full)
```
## INDEX

### ALARMS
- 73

### CHANGING KEYBOARD ASSIGNMENT
- 66
- CLEARING ALARMS
- 55
- COPYING SCREENS (is SERIES)
- 56

### DATA INPUT/OUTPUT
- 51
- DISPLAYING VERSION INFORMATION
- 57

### ETHERNET VERSION COMMUNICATION LOG FUNCTION
- 76

### FUNCTION KEYS
- 48

### INPUT FROM THE KEYBOARD
- 44
- INPUT WITH THE MOUSE AND TOUCH PANEL
- 47
- Installing the CNC Screen Display Function
- 4, 9, 13

### Operating Environment
- 2, 7, 12
- OPERATION
- 16

### PREFACE
- p-1

### Repairing and Uninstalling the CNC Screen Display Function
- 5, 10

### SAFETY PRECAUTIONS
- 8-1
- SETTING
- 58
- SETTING ANIMATED SIMULATION FOR TURNING
- 65
- SETTING SCREEN RESOLUTIONS
- 62
- SETTING THE DISPLAY TIMING AT STARTUP
- 64
- SETUP
- 1
- SETUP (ETHERNET VERSION)
- 7
- SETUP (HSSB VERSION)
- 2
- SETUP (is SERIES)
- 12

### Start
- 26, 37
- Start (Multiple Connection)
- 32

### START AND TERMINATION
- (ETHERNET VERSION)
- 26
- START AND TERMINATION (HSSB VERSION)
- 17
- START AND TERMINATION (is series)
- 37
- Starting the CNC Screen Display Function
- 17
- Starting the CNC Screen Display Function (Multiple Connection)
- 21
- SWITCHING BETWEEN DISPLAY LANGUAGES
- 60
- SWITCHING BETWEEN LOCATIONS TO SAVE THE SETTINGS
- 59

### Terminating the CNC Screen Display Function
- 24
- Termination
- 33, 39
- Termination by Means of the PMC Signal
- 35
- TYPES OF DISPLAYED SCREENS
- 40

### Uninstalling the CNC Screen Display Function
- 15
### Revision Record

**FANUC OPEN CNC  CNC Screen Display Function OPERATOR'S MANUAL (B-63164EN)**

<table>
<thead>
<tr>
<th>Edition</th>
<th>Date</th>
<th>Contents</th>
</tr>
</thead>
</table>
| 05      | Dec., 2004 | - Addition of Series 30i/31i/32i  
- Addition of Series 300i/310i/320i  
- Addition of Series 300is/310is/320is  
- Addition of Power Mate i  
- Addition of Series 0i |
| 04      | Dec., 2001 | Addition of “Copying the CNC screens” and “Series 160is/180is/210is MODEL B” in Appendix B |
| 03      | Dec., 1999 | - Addition of Series 160is/180is/210is  
- Addition of Series 150i-Addition of Ethernet |
| 02      | Oct., 1998 | Series 150-B was added.                                                   |
| 01      | Oct., 1997 |                                                                          |